Guidance for Industry: Availability of Templates for Toxicology Data; Mouse Lymphoma Thymidine Kinase Gene Mutation and Related Assays


Introduction to the Template for 

in vitro Mouse Lymphoma Thymidine Kinase Gene Mutation and Related Assays
March 2004
GENERAL INSTRUCTIONS:  You can navigate the template either by pressing the "arrow" keys or by using the mouse.  The sections expand as you type.  When you begin filling out a template, save it with a filename different from that of the form itself, so that you'll keep the blank template in your original file for future use.

To move quickly down the form to a specific section, click on the ‘View’ menu, then ‘Document Map’.  If you then click on a specific section name in the left-hand window, that section of the template will appear on the main screen.  Then close the left-hand screen to work on the form by selecting ‘View’, ‘Document Map’ again. 

In the event that the study contains additional types of information included as part of the experiment, you can add sections (with appropriate re-numbering) as needed.  This template will also accommodate tables prepared in Microsoft Excel and Microsoft Access.

Many of the yellow highlighted areas in headings contain comments in a pop-up balloon or as hidden text.  These are suggestions or instructions relevant to that particular section.  They may be viewed either by moving your mouse over the yellow highlighted areas or clicking on the ‘View’ menu, then ‘View Comments’ or ‘Markup’. To prevent the comments from appearing in the printed document, cancel the ‘Markup’ command or select ‘Document’ under ‘Print what’ when you issue the ‘Print’ command.

The templates were created in Microsoft Office 2000 software applications.  The comment sections in the templates may perform optimally with the same versions of the software applications.
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GENETIC TOXICITY STUDIES:

in vitro MOUSE LYMPHOMA THYMIDINE KINASE GENE MUTATION ASSAY AND RELATED ASSAYS

date of submission:

title of petition or notification: 
 


name and address of petitioner or notifier: 


I.
IDENTIFICATION OF ASSAY

A. assay file location (volume and page number(s)): 


B. assay title/report number: 


C. assay author or director: 


D. name and address of testing laboratory: 


E. date of assay report: 


F. dates assay conducted: 


G. study objective: 


H. comments: 


II.
GOOD LABORATORY PRACTICE

a.
is a good laboratory practice (glp) compliance statement included? 


b.
is a quality assurance (qa) statement included?  



c.
availability and location of original data/specimens/test substance: 


III.
MATERIALS AND METHODS
A. TEST SUBSTANCE 

1. chemical name: 

2. cas registry name: 
 

3. cas registry number: 
 

4. structure: 



5. purity: 


6. impurities:  
 

7. physical description: 


8. stability: 


9. comments: 


B. TEST SUBSTANCE AS ADMINISTERED

10. batch/lot number: 


11. vehicle used: 

12. tested for concentration? 


13. tested for stability? 


14. problems with storage? 


C. EXPERIMENTAL METHODOLOGY

15. test mammalian cells in culture

a type of cells: 

	
	Mouse lymphoma L5178Y TK +/-  -3.7.2C cells

	
	Other cells (specify): 


b cell culture media: 

c maintenance of cell cultures: 

Was the following information provided in a study report? (Check ‘Yes’ or ‘No’)  

	INFORMATION
	YES
	NO

	Properly maintained? 
	
	

	Periodically checked for Mycoplasma contamination?
	
	

	Periodically checked for karyotype stability? 
	
	

	Periodically "cleansed" against high spontaneous background?

	
	


d comments: 


16. in vitro metabolic activation system (s9 mix)

e composition: 
 


	COMPONENT
	CONCENTRATION OR AMOUNT (Unit)
	COMMENT

	
	
	

	
	
	

	
	
	

	S9 Fraction 

(details on induction, see below)
	
	


f s9 fraction: 


	INDUCED

OR NOT
	INDUCER USED
	ANIMAL

INDUCED*
	ANIMAL TISSUE USED FOR S9 FRACTION

	
	Induced
	
	Aroclor 1254
	
	Rat
	
	Liver

	
	
	
	Phenobarbital
	
	Mouse
	
	Lung

	
	
	
	Other (specify):


	
	Hamster
	
	Other (specify):



	
	
	
	
	
	Other (specify):


	
	

	
	Non-induced
	
	None
	
	None
	
	None


* Specify strain and sex of the animal induced.

Strain: 

Sex:


g comments: 


17. control materials
h negative or solvent control: 


	SOLVENT 

	CONCENTRATION

	
	

	
	


comments: 


i positive control(s) without metabolic activation:
	CHEMICAL  
	CONCENTRATION

	Methylmethanesulfonate (MMS) 
	

	Other

	


comments: 


j positive control(s) with metabolic activation:
	CHEMICAL
	CONCENTRATION

	Cyclophosphamide (CP)
	

	3-Methylcholanthrene (3-MCA) 
	

	Benzo(a)pyrene
	

	Other
	


comments: 


18. locus examined

	LOCUS
	SELECTION AGENT
	CONCENTRATION

	
	Thymidine kinase (TK)
	
	Trifluorothymidine (TFT)
	

	
	Others
	
	Others
	


comments: 


19. test compound and concentrations used

k preliminary cytotoxicity assay: 


	CONDITION
	TEST COMPOUND
	CONCENTRATION/SOLVENT

	NON-ACTIVATED 
	
	

	ACTIVATED 
	
	


comments: 


l mutation assay:

	CONDITION
	TEST COMPOUND
	CONCENTRATION/SOLVENT

	NON-ACTIVATED 
	
	

	ACTIVATED 
	
	


comments: 


D. TEST PERFORMANCE FOR MUTATION ASSAY 

20. cell treatment (table 1a and 1b): 


m method
: soft-agar ______________ or micro-well ________________
n table 1a.  summary of cell treatment without metabolic activation or s9 mix

	TREATMENT
	WITHOUT S9 Mix

	
	NUMBER OF CULTURES
	Treatment Period (hrs)
	Expression Period (Days)
	number of cells seeded per

plate or well
	Culture Period (Days)

	
	
	
	
	for

cloning efficiency
	for

mutant detection
	

	0  (solvent control)
	
	
	
	
	
	

	test dose 1
	
	
	
	
	
	

	test dose 2
	
	
	
	
	
	

	test dose 3
	
	
	
	
	
	

	
	
	
	
	
	
	

	positive control 1
	
	
	
	
	
	

	
	
	
	
	
	
	


o table 1b.  summary of cell treatment with metabolic activation or s9 mix

	TREATMENT
	WITH S9 Mix

	
	NUMBER OF CULTURES
	Treatment Period (hrs)
	Expression Period (Days)
	number of cells seeded per

plate or well
	Culture Period (Days)

	
	
	
	
	for

cloning efficiency
	for

mutant detection
	

	0  (solvent control)
	
	
	
	
	
	

	test dose 1
	
	
	
	
	
	

	test dose 2
	
	
	
	
	
	

	test dose 3
	
	
	
	
	
	

	
	
	
	
	
	
	

	positive control 1
	
	
	
	
	
	

	
	
	
	
	
	
	


p comments: 


21. statistical methods: 

 
22. evaluation criteria: 
 
IV.
RESULTS
E. PRELIMINARY CYTOTOXICITY ASSAY
 
23. table 2.  summary of preliminary cytotoxicity assay

	TREATMENT

((g/ml)
	WITHOUT S9 MIX
	TREATMENT

((g/ml)
	WITH S9 MIX

	
	RS
	RTG
	OTHER FACTORS
	
	RS
	RTG
	OTHER FACTORS

	0 (solvent)
	100
	1.00
	
	0 (solvent)
	100
	1.00
	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	


RS = Relative Survival (%)

RTG = Relative Total Growth

Other factors (if present, such as precipitation, nonphysiological pH, osmolality, etc.)

If other criteria are used for measurement of cytotoxicity, modify the table and enter those experimental data.

Detailed explanations can be found in the Redbook, Section IV.C.1.c., Mouse Lymphoma

Thymidine Kinase Gene Mutation Assay.

24. comments: 


F. MUTATION ASSAY
 

25. table 3a.  summary of mutation assay without metabolic activation or s9 mix
	TREATMENT (µg/ml)
	WITHOUT S9 MIX

	
	RS
	RTG
	MF

(NOTE STATISTICAL SIGNIFICANCE
	NUMBER OR % COLONIES

	
	
	
	
	LARGE
	SMALL

	0 (solvent control)
	100
	1.00
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	LINEAR TREND (IF CONDUCTED):



	positive control
	
	
	
	
	


26. comments: 


27. table 3b.  summary of mutation assay with metabolic activation or s9 mix
	TREATMENT (µg/ml)
	WITH S9 MIX

	
	RS
	RTG
	MF

(NOTE STATISTICAL SIGNIFICANCE)
	NUMBER OR % COLONIES

	
	
	
	
	LARGE
	SMALL

	0 (Solvent Control)
	100
	1.00
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	LINEAR TREND (IF CONDUCTED): 

	Positive Control
	
	
	
	
	


Refer to the Redbook guidelines at http://www.cfsan.fda.gov/~redbook/redivc1c.html for the definitions and considerations of the terminology below:

RS = Relative Survival (%)

RTG = Relative Total Growth

MF (Mutant Frequency) = Mutants/106 viable cells 

Notation of Statistical Significance

NS (Not Significant) or 

S (Significant) at * (P-value < 0.05) or ** (P-value < 0.01)

28. comments: 


V.
OVERALL ASSESSMENT AND SUMMARY

G. ASSESSMENT OF STUDY
H. SUMMARY

VI.
REFERENCES
� FDA recommendations for conducting a gene mutation assay in mouse lymphoma cells in vitro are contained in � HYPERLINK http://www.cfsan.fda.gov/~redbook/redivc1c.html ��http://www.cfsan.fda.gov/~redbook/redivc1c.html�.  FDA recommends use of the mouse lymphoma assay using L5178Y TK+/- -3.7.2 C cells because the assay can detect point mutations and chromosomal events.





�Indicate Yes or No for the Questions A and B.  However, you may want to elaborate on the type of GLP compliance (USFDA, OECD, etc.) or make other notations.


�PAGE \# "'Page: '#'�'"  ���� If the molecular structure is not provided with the study, it may be available from a source such as Chemfinder (� HYPERLINK "http://www.chemfinder.com" ��http://www.chemfinder.com�) or ChemIDplus (� HYPERLINK "http://chem.sis.nlm.nih.gov/chemidplus/" ��http://chem.sis.nlm.nih.gov/chemidplus/�).  The CAS number is the preferred search term if you have it, otherwise try the common name or any synonyms given. If the correct structure is found on Chemfinder or ChemIDplus, the image can be downloaded and inserted into your report.  If the structure is not available, enter ‘Not available’.





�Indicate how the test substance was administered and whether any vehicle was used to dissolve/suspend the test substance (e.g., dissolved in dimethylsulfoxide).  Describe how adequate testings for concentration and stability were done.  How was the test substance in vehicle, etc., stored before being used in the assay? Note anything that was not normal or routine.





�Provide adequate details so the information can be used to help prepare your report. Use the comments to indicate additional information about the experimental design.  To change the table, place cursor in the row or column that you wish to modify, then from the ‘Table’ menu, use ‘Select Row’ or ‘Select Column’ to highlight the row or column that you wish to change, and use the ‘delete’ or ‘insert’ functions to make your changes.





�PAGE \# "'Page: '#'�'"  ���� List the components and concentrations of cofactor solutions as well as the amount of S9 fraction in the S9 mix.  If S9 mix was purchased, provide details.





�PAGE \# "'Page: '#'�'"  ���� If all table rows are used, add additional rows by clicking the left mouse button in the last cell (bottom right) and pressing the TAB key.





�PAGE \# "'Page: '#'�'"  ���� If no preliminary cytotoxicity assay was performed, enter ‘not performed’.





�PAGE \# "'Page: '#'�'"  ����Either a soft-agar or micro-well method can be used for the detection of mutants and measurement of cloning efficiency.   Copy and paste additional tables to this section, if needed.





�PAGE \# "'Page: '#'�'"  ���� State which data were analyzed and what statistical methods were used.





�PAGE \# "'Page: '#'�'"  ���� Summarize the testing laboratory’s criteria for an acceptable assay and for a positive and negative response.





�PAGE \# "'Page: '#'�'"  ���� Enter the data requested in the table.  Additional rows can be added to the table using standard Word commands.





�


Relative survival (RS): 


The relative cloning efficiency of the test culture plated immediately after cell treatment and compared to the cloning efficiency of the negative control.





� HYPERLINK http://www.cfsan.fda.gov/~redbook/redivc1c.html ��http://www.cfsan.fda.gov/~redbook/redivc1c.html� for more information.


�


Relative total growth (RTG): 


RTG is used as the measure of treatment-related cytotoxicity in the assay.  It is a measure of growth of test cultures (relative to the vehicle control) both during the two-day expression and mutant selection cloning phases of the assay. The RSG of each test culture is multiplied by the relative cloning efficiency of the test culture at the time of mutant selection and expressed relative to the cloning efficiency of the vehicle control.





Relative suspension growth (RSG): Relative total two day suspension growth of the test culture compared to the total two-day suspension growth of the vehicle control.





� HYPERLINK http://www.cfsan.fda.gov/~redbook/redivc1c.html ��http://www.cfsan.fda.gov/~redbook/redivc1c.html� for more information.


�PAGE \# "'Page: '#'�'"  ���� Enter the data requested in summary tables.  If a linear trend test was conducted, enter the results. In addition, briefly describe any pertinent information, such as appropriateness of cloning efficiencies, appropriateness of control values (include the testing laboratory’s historical control ranges if provided) and the testing laboratory’s criteria for differentiating large versus small colonies.  If more than one mutation assay is reported, copy and paste Tables 3A and 3B and make the appropriate changes (i.e., the headings of the new tables).





�Relative survival (RS): 


The relative cloning efficiency of the test culture plated immediately after the cell treatment and compared to the cloning efficiency of the negative control.





�Relative total growth (RTG): 


RTG is used as the measure of treatment-related cytotoxicity in the assay.  It is a measure of growth of test cultures (relative to the vehicle control) both during the two-day expression and mutant selection cloning phases of the assay. The RSG of each test culture is multiplied by the relative cloning efficiency of the test culture at the time of mutant selection and expressed relative to the cloning efficiency of the vehicle control.





Relative suspension growth (RSG): Relative total two day suspension growth of the test culture compared to the total two-day suspension growth of the vehicle control.





�PAGE \# "'Page: '#'�'"  ���� Briefly summarize the study and discuss deficiencies.    





1

